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Disclaimer: Product and Documentation Status

This documentation belongs to a pre-release version of OmniWeb 5. Both the

product and the documentation are under construction. You will undoubtedly

find that the documentation is not fully complete or correct. Specifically, this

version of the documentation is vulnerable to incompleteness or outright errors,

as a result of:

• Rapidly changing features.

At the time we make pre-release versions available to the public, the

software is mostly finished. However, “mostly complete” is not the same as

“carved in stone”. During the period leading up to the final release, we

change features in response to both our internal testing and the responses

of users. Since a web browser is largely user interface, this means that

through the pre-release period, the software’s look and behavior will change.

Check to make sure that this documentation applies to the version of the

software you have in hand.

• Documentation development.

The software isn’t quite finished yet, and neither is the documentation.

Fundamentally, the writers of this documentation are in the same position

you are: dealing with an almost-done application. Here are some things that

are missing or incomplete: screenshots (some are present, but not even close

to all of them), the index, coverage of some late-breaking features. Wherever

there is meant to be a screenshot that has not appeared yet, you will see the

Under Construction icon. There are probably more problems with the

documentation, as well; please make a report to our overworked support

team if you find outright errors in the manual.

Please note that if you try to make sense of this documentation with any other

version of OmniWeb, either previous or future, you will be very sorry. Unless

you like manuals that have no relation to the product you are using.
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OmniWeb 5: an overview

OmniWeb 5 is designed to help you manage your web browsing experience

completely, while not creating a great deal of extra work for you. We recognize

that most of our customers already know how to use a web browser, and you

can transfer those skills to OmniWeb immediately. In fact, if you want to, you

can simply use OmniWeb just like you would use any other browser. We have no

idea why you would want to do this, since the point of OmniWeb is to bring you

more powerful features that let you control every aspect of your web

experience. On the other hand, the fact that OmniWeb’s basic operation is just

like any other browser you might have used means that you can pick and

choose which of our cool features you want to use at any given time.

What’s New in OmniWeb 5?

There are lots of changes in OmniWeb 5, but the four most obvious are Tabs,

Workspaces, Bookmarks and enhancements of how Preferences work.

Tabs

OmniWeb 5 tabs are not your average run-of-the-mill tabs. Our tabs provide you

with real information about the pages they represent, which makes them both

more powerful and easier to use. OmniWeb builds on the idea of viewing

multiple web pages in a single window by offering thumbnails and powerful

drag-and-drop capabilities.

When you create a new tab in your tab drawer, the page is represented by a

thumbnail graphic of the website it represents. You can switch between tabbed

pages just by clicking on thumbnails. Drag thumbnails to change their position

in the tab drawer, drag links into the tab drawer to create new tabs, or drag and
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drop tabs from one window to another. If you have a large enough screen, you

can even resize the thumbnails and read webpages right there in the tab drawer.

Workspaces

Do you have different browsing personalities? Do you have a set of windows

you like to have available while shopping on the web? Are these different than

the sites you like to have available when you are blogging? Maybe you are

engaged in a research project, and there are a half dozen sites you need to visit

every time you sit down to work on the project. If so, you know what a nuisance

it is to have to set up your browser every time you want to engage in one of the

activities. If you are doing more than one thing at a time, it gets even worse. And

then if you need to reboot your computer, you lose your setup; once the

machine is back on-line, you have to spend time setting up your browser

environment all over again.

OmniWeb 5 addresses these issues by introducing workspaces. With this

feature, you can save your individual browsing sessions in one convenient

location. When you create a workspace, OmniWeb saves information like which

web pages you have in your open in tabs, your history, and the location of the

windows on your screen. You can drag and drop things between workspaces,

letting you reorganize your work quickly. Take a snapshot of a workspace so

that you can restore a workspace to its current status, clearing away any

changes made to the workspace in the meantime. It’s easy to move between

workspaces by clicking on their names. You can mail a workspace to another

OmniWeb 5 user, sharing an entire browsing experience by sharing just one file.

Bookmarks

OmniWeb 5 offers you the most powerful bookmarks we could cram into the

application. We’ve added new ways to obtain bookmarks, new things to do with

them once you have them, and new ways to organize them.
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OmniWeb lets you share your bookmarks using Rendevous, making your

favorites accessible to other OmniWeb users on your local area network.

Bookmark Collections offer several new features including a listing of all web

servers available on your LAN and filtered views of bookmarks and history. You

can use these filters to see what websites your have visited most often.

OmniWeb 5 can also tell you which of your bookmarked pages have new content

since the last time you visited each one. OmniWeb lets you view XML/RSS feeds

right in your bookmark window.

As bookmark collections get bigger, it gets easier to lose bookmarks, so we’ve

built in a bookmark search feature that makes it easy to find specific

bookmarks. We’ve also added the ability to define shortcuts for bookmarks.

Once you define a shortcut, you can get to a bookmarked page just by typing

the shortcut in the Location bar — you don’t even have to visit the bookmarks

page.

Preferences

OmniWeb 5 provides you with complete control over your browsing experience.

Like previous versions, this one lets you do things like blocking ads, killing pop-

ups and pop-unders, and manage which plug-in content you want to see.

However, we’ve given you lots more control over how preferences work. After

you have set the defaults for your browsing experience, you can now override

those default in the cases of specific domains.

Have you blocked ads, but your favorite satire site has joke ads you want to see?

Just change the ad-blocking preferences for that one site. You can change the

font size for websites that you can’t read (because the type is too small) or that

won’t fit on your display (because the type is too big), without making all

websites change in the same way. You can even set site-specific defaults for

downloading files.
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About this Manual

This manual is a guide to the powerful features of OmniWeb 5. It focuses on the

new and powerful things that are different than other browsers. If you need

specific information about menus and commands, please refer to the online

help.

We’ve designed this documentation as an extended Frequently Asked Questions

list. The questions are organized by general area of inquiry. Within each section

of the manual, you will find a listing of all the questions on that topic area.
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Setting and Overriding OmniWeb 5 Defaults

OmniWeb 5 lets you control almost every aspect of your browsing experience.

Your basic approach to setting up your browser should be to decide how you

want OmniWeb to behave most of the time. Use the application preferences to

set these behaviors as the default. Then set site-specific preferences to override

the defaults on specific web pages where you want different behavior.

• What can I control using preferences?

• How do get OmniWeb to store user names and passwords for various web

sites?

• Is it safe to have OmniWeb store my passwords?

• What stuff can I block?

• How do I block pop-ups and pop-unders?

• What is the Pop-up Trap?

• How do I block advertising?

• What kinds of plug-in content can I block?

• How do I block plug-in content?

• What kind of control can I exercise over cookies?

• How do I set the preferred window size and location?

• How do I override general preferences for a specific domain?

• How do I move my preferences to a different computer?
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What can I control using preferences?

You can control almost anything about the browsing experience using

OmniWeb’s application preferences. To get to the OmniWeb Preferences pane,

select Preferences… from the OmniWeb menu.

Figure 1: OmniWeb’s Preferences Pane

This Preferences pane, you can configure these settings:

• General Preferences

⇒ Your Start Page

⇒ Whether or not the Location bar auto-completes URLs as you type

⇒ Whether you can navigate by voice

• Tabs and Windows

⇒ Where the tab drawer opens
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⇒ Window behavior, including whether a window appears at start-up,

whether links open in the same window or a new window, and the

behavior of alternate link-clicking key combinations

• Display

⇒ When page-drawing starts

⇒ Font smoothing

⇒ Whether clicked links look different than unclicked links

• Bookmarks

⇒ Whether bookmarks show in the current window or a new window

⇒ How often OmniWeb checks all bookmarks for changed page content

⇒ How to file new bookmarks

⇒ Whether or not to share your bookmarks on the Local Area Network

(LAN)

• Downloads

⇒ How long OmniWeb should remember what files you have downloaded

from where

⇒ How to handle downloads, including setting applications which can

automatically open downloaded files

• History

⇒ Whether to save History information between sessions

⇒ How long to save it, if you decide to save it

⇒ How much space to allocate for caching web content, and whether to

validate that content before using it

• AutoFill

⇒ What information can be used to autofill web forms

⇒ Create and manage a library of phrases that can be automatically

completed if you ever type them again in a web form
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• Shortcuts

⇒ Create and manage shortcuts that you can type into the Location bar to

get to a web page quickly

• Source View

⇒ Configure the HTML source editor, with colors and highlighting to

distinguish HTML code from content

⇒ Set up OmniWeb to help you update pages that you create and publish to

the World Wide Web

• Plug-ins

⇒ Manage which applications will handle what kind of MIME content

⇒ Determine which kinds of plug-in content will be loaded and executed on

download

• Update

⇒ Configure OmniWeb to check http://www.omnigroup.com for updates on

a regular basis

• Appearance

⇒ Determine how OmniWeb will display pages, including selecting font sets,

determining whether links will be underlined, and how images will be

handled

• Ad Blocking

⇒ Deal with pup-ups and pop-unders

⇒ Determine how many times animated images should play their

animations (hence eating CPU) before they stop

⇒ Create general defaults for locating and blocking ads

⇒ Create and manage blacklists and whitelists of ad source sites

• Languages

⇒ Set text encoding preferences for rendering pages and submitting forms
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⇒ Attempt to get web pages in your favorite language

• Security

⇒ Control how Javascript and Java are allowed to run within OmniWeb

⇒ Set rules for accepting and keeping cookies

• Other

⇒ Set a default download target location

⇒ Change how your browser identifies itself — have hours of fun spoofing

web sites into thinking you are running a different browser

⇒ Turn AutoComplete on for forms

For detailed information about these preferences, please refer to the on-line

help. Note that any preference pane can be set back to its defaults by clicking on

the  button. If you press the Option key, this button will toggle to ,

so that you can reset all the preferences to be the way they were when se

shipped you OmniWeb 5.

How do I get OmniWeb to store user names and passwords
for various web sites?

On the Form AutoFill Preferences pane, click on the check box labeled User
Names and Passwords.

Is it safe to have OmniWeb store my passwords?

Yes. OmniWeb stores password information in the secure Keychain provided by

Mac OS X.
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What stuff can I block?

You can have OmniWeb block pop-up windows, including the annoying kind

that appear under your main browser window, and that you do not see until

much, later. You can also set up OmniWeb to block ads, images that might be

ads, and images that are links to sites you hate. Finally, you can prevent

OmniWeb from loading certain MIME-type content.

How do I block pop-ups and pop-unders?

On the Ad-Blocking Preferences pane, you may choose to allow pop-ups to

load, or you may tell OmniWeb never to load pop-ups, or you can instruct

OmniWeb to load pop-ups only when you have specifically requested them (for

example, by clicking on a link that is set up to open a pop-up). You can also tell

OmniWeb to open pop-ups windows in the Pop-up Trap.

What is the Pop-up Trap?

If you set your preferences to open pop-ups in the Pop-up Trap, then OmniWeb

will load but not open pop-up windows. Instead, an icon will appear in the

Status bar at the bottom of the browser window indicating that there are pop-up

windows that have been trapped. Click on it to show a menu listing all the

trapped popups for the current tab. To open a pop-up, just select it from this

menu
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How do I block advertising?

By blocking pop-ups (or at least unrequested pop-ups), you can block much of

the advertising that comes along with web browsing. OmniWeb can try to be

even smarter, if you want. On the Ad-Blocking Preferences pane, you can tell

OmniWeb what kind of guesses it is allowed to make and act on about images

that are part of a web page you are loading.

For example, there are standard sizes for “banner ads” on wed sites. To have

OmniWeb decline to load images that are one of these standard sizes, click the

check box labeled Matching known ad sizes.

Most ads are not loaded from the web site where you view them. Instead the

web page you are looking at reaches across the web to a third-party site to load

advertising content. OmniWeb can refuse to do this, if you click the check box

marked From third-party sites.

Finally, many ads are propagated through well-known ad sites. If you would like

OmniWeb to block images and other in=line content that loads from one of

these sites, click the box labeled From blocked URLs.
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If you would like to edit the list of blocked sites, click on the button labeled Edit

Blocked URLs List… . By selecting the Black List pane, you can add sites whose

linked content you do not want to see.

On the White List pane, you can override all ad-blocking settings, including

loading from third party sites, image sizing, and so on. Any domain you enter in

your White List will be allowed to load images, regardless of other settings.

What kinds of plug-in content can I block?

You can block any kind of registered plug-in content.

How do I block plug-in content?

Go to the Plug-ins Preferences pane. This panel shows a list of all plug-ins and

the associated applications. Next to each plug-in is a check box.

To block content that uses that application, uncheck the box. Note that before

changes to this panel can take effect, you must restart OmniWeb.
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What kind of control can I exercise over cookies?

On the Security Preferences pane, you can configure how OmniWeb handles

cookies. If you do not want to accept any cookies at all, just uncheck the box

labeled Accept cookies.

If you choose to accept cookies, you can still exercise control over how this is

done. To decline cookies that are sent from a site other than the one you are

viewing, click next to Only from the current site.

To throw away all cookies from a session when you shut down OmniWeb, click

the box labeled Discard when quitting OmniWeb.
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How do I set the preferred window size and location?

Set a browser window to the size and location you prefer. Select Save Window
Size from the Window menu. The next time you open a new browser window, it

will open like the saved one, except that if there is already a window in that

location, it will offset itself to the right to avoid completely covering the existing

window.

How do I override general preferences for a specific
domain?

Load a page from the domain whose preferences you want to alter. Select the

Show… sub-menu from the View menu; from the sub-menu, select Show Site
Preferences.

On the bottom half of the browser window, the Site Prefereences pane will

appear. Note that in the same pane, you can also choose to see the Show Page

Info pane.

As you page through Page Appearance, Ad Blocking, Languages, Security, and

Other, you will see that they are entirely similar to the general preference panes

described above. Here, you can make different choices for these items, and the

choices you make will apply only to pages in the same domain as the current

page. You can tell what domain that is by looking at the label of the pane.
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If you make any changes so that a site-specific preference is different than your

defaults, a small blue button appears to the right of the preference. To revert to

the defaults you have set, click on that button.

How do I move my preferences to a different computer?

OmniWeb 4 preferences are stored in a preferences file (located wherever your

preferences are stored) called com.Omnigroup.OmniWeb5.plist. If you need to

move your preferences to another computer, simply copy this file into the

preferences Library on the new computer.
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OmniWeb Tabs

OmniWeb has an expanded notion of tabs, compared to most other browsers. In

this section, we address questions related to the tabs interface.

• How do OmniWeb 5 tabs work?

• What are all those little icons that sometimes appear on my tabs?

• What are the shortcuts I can use with tabs?

• I have too many tabs! How can I see them all?

• How can I tell the difference between two tabs that look very similar?

• How do I move a tab from one window to another?

• What else should I know about tabs?

How do OmniWeb 5 tabs work?

OmniWeb stores tabs in the kind of drawer that is familiar from other OS X

applications. You can place this drawer to the left or right of your browser

window. In the drawer, each tab appears as a thumbnail image of the web page

it represents.

You can drag and drop tabs between one window and another. You can also

copy and paste a tab from one window to another. If you don’t like the order in

which the tabs appear in the drawer, simply drag and drop to rearrange.
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What are all those little icons that sometimes appear on my
tabs?

Tabs provide status information through badges. When the content represented

by a tab is still loading, a rotating badge appears on the tab.

When a tab that you have not viewed yet is finished loading, a green badge

appears on the thumbnail.

If there is a error in a tab, an exclamation point badge appears on the tab.

What are the shortcuts I can use with tabs?

Command-T creates and selects a new tab.

Command-option-T shows the tab drawer.

Command-click defaults to "Open in a new, inactive tab". You can use the Tabs

& Windows preferences to change how this shortcut works. The choices are:

⇒ Open in a new, inactive tab

⇒ Open in a new active tab

⇒ Open in a new window behind the current window
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⇒ Open in a new window in front of the current window

When you have two or more tabs in a window, Command-W closes the current

tab. In this case, Command-Shift-W closes an entire window and all its tabs,

after you have confirmed that you want to do this.

Double-click on a tab in order to open it in its own window.

I have too many tabs! How can I see them all?

You have two choices. You could make the thumbnails smaller by making the

tab drawer narrower. This stops being useful pretty quickly, since as the

thumbnails get smaller, they get less  easy to tell apart. (Note that if you change

the size of the tab drawer, the next time you create a tab drawer on a window, it

will remember the changed size and use that.) The better choice is probably to

switch from the thumbnail view to the list view of the tabs. You do this by

clicking on the list icon at the top of the tab drawer.

 turns into this: 

How can I tell the difference between two tabs that look
very similar?

Well, you could click on each one in turn, and compare the web pages that are

displayed. Another choice is to make the drawer bigger. Since the thumbnails
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always size themselves to fill the width of the drawer, widening the drawer is a

quick way to make them larger. This may make it easier to tell them apart. (Note

that if you change the size of the tab drawer, the next time you create a tab

drawer on a window, it will remember the changed size and use that size for the

new drawer.)

How do I move a tab from one window to another?

Simply drag it from the tab drawer in the first window to the tab drawer in the

second window. The tab will disappear from the first window and appear in the

second window.

If you want to replace one tab with another tab, hold the Command key while

you drag a tab onto another tab. This will replace the dragged-onto tab with the

tab you are dragging.

What if I want the tab in both the first window and the
second window?

In that case, click on the thumbnail of the tab you want in both places. Copy the

selected tab to the clipboard. Then select the destination browser window and

paste the tab into the new window. It should appear in the tab drawer.

You can also paste a tab by clicking anywhere in the destination except the

Location bar.

What else should I know about tabs?

You can turn a bookmark into a tab by dragging it into the tab drawer. You can

even drag an entire folder of bookmarks and create a whole slew of tabs all at

once.
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If you open more than one HTML file from the disk, they will load into a single

window, each file turning into a tab.



25

Workspaces

We recognize that you use your web browser for many different types of

activities. Each of these activities may require a different set of windows and

arrangement of these window on the desktop. OmniWeb 5 helps you manage

this by giving you the ability to save a particular setup as a named workspace.

The next time you want to use the same arrangement of windows, you can

simply invoke the workspace by name, and it reappears.

In addition, you can take snapshots of a workspace. This lets you try out new

combinations of windows and screen arrangements, and if they don’t work out,

then you can return to the snapshot version. It makes playing around with your

workspaces risk-free.

• How do I set up a workspace?

• What does a workspace know about the windows in it?

• What is the default workspace?

• How do I move between two or more workspaces?

• How do I move windows into an existing workspace?

• How do I take a snapshot of a workspace?

• How do I return a workspace to an earlier snapshot?

• What are all the things I can do in the Workspaces pane?

How do I set up a workspace?

When you have an arrangement of windows that you want to save as a

workspace, select New Workspace from the Workspace menu. Give your new

workspace a name and click on OK.
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To see that your workspace has been created, check the bottom of the

Workspace menu. Your new workspace has been added to the list of

workspaces.

What does a workspace know about the windows in it?

A workspace remembers all the windows you have open, including:

⇒ Tabs (including whether your tabs are shown with thumbnails or in a list

⇒ Browsing history

⇒ Whether each window is minimized or not

⇒ Scroll position of each window

When you create a workspace, you can tell OmniWeb whether or not to save the

windows in the workspace. This choice is on by default, and is what makes

OmniWeb open the workspace next time just as you left it when you quit the

browser.

What is the default workspace?

In OmniWeb 5, you are always working in a workspace. Even if you have not

created any workspaces yet, the application creates one called Default. The

default workspace starts out with the save window feature turned off. This

means that when you quit the browser out of this workspace, OmniWeb forgets

about the windows, and the next time you start OmniWeb, you get only one

window with your Start Page in it.
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(We set the default workspace up this way so that no user has to know about

workspaces if she does not want to. If you use only the default workspace and

you do not change the save windows setting, then OmniWeb 5 acts like previous

versions of OmniWeb when you shut down and start up the browser.)

How do I move between two or more workspaces?

There are three methods for doing this.

Method 1: Workspace Menu

Simply select the workspace you wish to use from the Workspace menu.

Method 2: The Workspaces Pane

Open the Workspaces pane by selecting Show Workspaces from the Workspace
menu. In this pane, you will find a list of all your workspaces. Double-click on

the one you wish to use, and OmniWeb will switch to that workspace.

Method 3: Toggling Workspaces

On the Workspace menu, use Next Workspace and Previous Workspace to cycle

through all your workspaces. There are keyboard short cuts for these actions,

too: Command-Control-<RightArrow> shows the next workspace and

Command-Control-<LeftArrow> shows the previous workspace.
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How do I move windows into an existing workspace?

If you are in one workspace and you open a window that you realize you would

like to have in another workspace, open the Workspaces pane. Your current

window will be listed in the highlighted workspace. Simply drag it over to the

left side of the pane and drop it on the name of your target workspace.

How do I take a snapshot of a workspace?

In the Workspaces pane, select the workspace you wish to record. Click on the

 icon at the bottom of the pane to create the snapshot. When the snapshot is

complete, the same icon will appear next to the name of the workspace.
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If you decide you do not want to keep the snapshot, you can eliminate it by

selecting Delete Snapshot from the Workspace menu.

How do I return a workspace to an earlier snapshot?

If you decide you liked a workspace better when you took the snapshot of it

than you do now, you can revert to the snapshot version. There are two ways to

do this.
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Method 1: The Workspaces Pane

In the Workspaces pane, select the workspace you wish to restore. Click on the

 icon to restore the workspace to the way it was when you took the

snapshot.

Method 2: The Workspace Menu

Make sure that the workspace you want to restore is the active workspace. Then

select Restore Snapshot from the Workspace menu.

What are all the things I can do in the Workspaces pane?
• Drag windows between workspaces

• Modify the save windows setting for each workspace

• Rename a workspace by Option-clicking the name of the workspace or by

carefully clicking the name of an already selected workspace

• Single-click a workspace icon to see the windows in that workspace

• Double-click an item in the workspaces list to activate the workspace (but if

the windows column of the workspaces pane is hidden, just Single-click to

switch between workspaces)
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OmniWeb Bookmarks

In OmniWeb 5, your bookmarks are, in many ways, the heart of your browsing

experience. OmniWeb bookmarks are dynamic, not static (except when you want

them to be), and they work well with lots of other tools and technologies to

provide you with an integrated browsing experience.

• Where can I find my bookmarks?

• How do I import my bookmarks from another browser?

• How do I make a new bookmark?

• Where can I find more information about a particular bookmark?

• Can I rename my bookmarks?

• What is the bookmark shelf?

• How can I organize my bookmarks?

• What are the columns in the bookmarks display?

• How can I sort my bookmarks?

• I know I bookmarked that page! How can I find it?

• What are those icons next to my bookmarks and folders?

• How do bookmarks interact with tabs?

• What are all those bookmarks that came with OmniWeb 5?

• How can I check to see which bookmarks have new content?

• How can I check to see which bookmarks have become useless pointers to

nothing?

• How do I share my bookmarks with others on my LAN?

• Can I use my bookmarks to help me deal with complicated web pages that

have a lot of links on them?
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• What happens to a bookmark if the web site it points to does a permanent

redirect?

• Can I make bookmarks that take advantage of XML/RSS feeds?

Where can I find my bookmarks?

Bookmarks appear in a wide editing area (this is a change from previous

versions of OmniWeb, where bookmarks appeared in a drawer). You can either

open your bookmarks in the browser window or in their own window. OmniWeb

5 ships with bookmarks opening in the browser window; you can change this

behavior in the Bookmarks preferences.

Once you have set your preference, you can always make bookmarks open the

other way by holding down the Option key while you open the bookmarks.

When you open bookmarks in the browser window, OmniWeb treats it as a web

page for History purposes. This means you can move in and out of bookmarks

by using the Back and Forward tool bar buttons.

If you want to, you can even create a tab for your bookmarks, which lets you

navigate to them using tab navigation features.

How do I import my bookmarks from another browser?

The first time you run OmniWeb 5, it automatically imports your bookmarks

from OmniWeb 4.x. What? You mean bookmarks from some other browser? Oh,

all right.

Select Import Bookmarks… from the Bookmarks menu.
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Use the drop-down menu to select the browser you want to import from. Click

Import. If the browser you want is not listed in the menu, click Choose Other…

and use the navigation window to find the bookmarks you want to import.

How do I make a new bookmark?

The easiest way is to bring up the page you want to bookmark in your active

window and then select Add to Bookmarks… from the Bookmarks menu.  The

first time you ever do this, a pane appears asking you to specify a bookmark

folder and a name for the new bookmark. When these choices are correct, click

on OK.

If you do not want to see this pane again, be sure to click the bow next to the

words Don’t show this again. If you check it (so thereafter most bookmarks use

the page title for their name and are placed in the folder you specified in the

Bookmark preferences), you can get the pane to come up when you need it for a

particular new bookmark: just hold down the Control key while you select the

menu item.
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Where can I find more information about a particular
bookmark?

Select the bookmark and click Command-I. This brings up the Bookmark Info

panel at the bottom of the browser window.

One especially cool thing about this window is that it lets you create a Keyword

for your bookmark. Once you have done this, you can quickly navigate to the

bookmarked page by typing the keyword in the Location bar.

In this area, you can also set a different schedule for checking this bookmark

for updates. You can even force OmniWeb to check for updates right now.

This is where you can enter notes about your bookmarks most easily. These

notes are searchable.

Can I rename my bookmarks?

Yes. If you want to rename them when creating them, make sure you bring up

the optional pane described in the previous question. To rename an existing

bookmark, select it, and then single-click on it. This will allow you to type a new

name for it.

What is the bookmark shelf?

In the bookmarks window, the shelf is the area to the left of the list of

bookmarks. It contains two lists, separated by a divider. Above the divider is a

list of collections, and below the divider is a list of your top-level bookmarks
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folders. By clicking on one of these items, you tell OmniWeb what bookmarks to

display in the main part of the window.

Use the icon at the bottom left of the shelf to add and subtract collections from

the visible list. You can simply drag the collections around to reorganize their

order.

The collections are:

⇒ Address Book: all the URLs in your AddressBook are turned into

bookmarks

⇒ History: your browser history, turned into bookmarks

⇒ Most Visited: the 8 sites that you have visited most often

⇒ Local Web Servers: OmniWeb uses Rendevous to list all http servers on

your LAN as bookmarks

⇒ My Shared Bookmarks: a holder for bookmarks you want to share with

other OmniWeb 5 users; simply copy items into this collection and other

OmniWeb 5 users can then see your shared bookmarks in their Shared

Bookmarks collection  Note: You can only share bookmarks if you have

turned on Bookmarks Sharing in Bookmarks preferences

⇒ Shared Bookmarks: the bookmarks being shared by other OmniWeb 5

users on your local network

⇒ Site Preferences: a list of all domains for which you have custom

preferences set (select a domain — and then View > Show > Site

Preferences if necessary — to see the custom preferences; you can delete

a domain from the list to remove all preferences for that domain)

⇒ Unreachable: a list of all bookmarks for web pages that were unavailable

for one reason or another the last time OmniWeb tried to check the

bookmark for changes

⇒ Unviewed Content: a list of those bookmarks that have been updated

since you last viewed them
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⇒ [Other browser name] Bookmarks: if you imported bookmarks, a

collection is created for each browser you got bookmarks from, and every

time you restart OmniWeb, it checks to see if your [other browser]

bookmarks are changed; if so, this collection will be updated to reflect

the changes

⇒ News Feed: bookmarks created by XML/RSS feeds

How can I organize my bookmarks?

You can create folders to hold your bookmarks. You can use the Actions icon at

the bottom of the main bookmarks list; select Add Bookmarks Folder from the

pop-up menu. Alternatively, you can simply click on the Add Folder icon. You

can drag bookmarks into folders and nest folders as deeply as you care to. The

Actions icon menu also lets you create separators for your bookmarks, which

you can drag to the location where you want them.

What are the columns in the bookmarks display?

The bookmarks display has several columns, which you can configure to please

yourself. By default, the columns displayed are:

⇒ Status: shows new content or unreadable content

⇒ Label: the bookmark name

⇒ Address: the URL associated with the bookmark (for folders, this column

shows the number of items in the folder)

⇒ Last Visited: the date you last looked at the bookmark

There are three other columns that do not display by default:

⇒ Note: annotations you make to your bookmarks

⇒ Visit Count: how many times you have visited this bookmark

⇒ Searchable by Content: which displays a magnifying glass if you can

search the page content
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To change which columns are displayed, Control-click on any column heading

and use the context menu that appears to select which columns should be

visible. To move columns around, just drag and drop them, using the column

headers as handles.

How can I sort my bookmarks?

Click on a column heading to sort using that column’s content. There is a three-

stage cycle when you click on a column heading. The first click sorts in in that

column order. The second click sorts in reverse of that column order. The third

click takes you back to the order you created manually.

I know I bookmarked that page! How can I find it?

At the bottom of the bookmarks window, there is a search field. In the shelf,

select the bookmark folder or collection that you wish to search. Then enter a

search phrase and press Return.

You can control the scope of the search by using the drop-down menu on the

search field. Simply select the scope you wish to apply to the search from the

menu, and proceed.
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What are those icons next to my bookmarks and folders?

In the Status column, OmniWeb displays two different icons to show you the

status of your bookmarks.

The green checkmark means that there is new content on that page since the

last time you visited it. The yellow exclamation point means that the page has

become unreachable.

How do bookmarks interact with tabs?

You can create tabs by dragging bookmarks into the tab drawer. You can even

drag a folder of bookmarks into the drawer, creating a whole lot of tabs all at

once. If you drag a folder into the browser window instead, OmniWeb replaces

the current tabs with tabs created from the folder contents.

What are all those bookmarks that came with OmniWeb 5?

Top-level bookmarks folders appear below the divider on the bookmarks shelf.

OmniWeb 5 ships with a bunch of bookmarks folders to get you started. If you

like them, great! If not, feel free to get rid of them and make your own.

How can I check to see which bookmarks have new
content?

OmniWeb automatically keeps track of this for you. Once you have visited a

bookmarked site, if the content changes, a green checkmark appears in the

status column in the main bookmarks area. Also, the OmniWeb 5 icon in the

Dock shows the number of updated bookmarks.
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How can I check to see which bookmarks have become
useless pointers to nothing?

When OmniWeb checks a bookmarked site for updates, it may discover that the

webpage has become unavailable. If this happens, a yellow exclamation point

will appear in the status column in the main bookmarks area. This icon will also

attach to containing folders for the affected bookmark.

How do I share my bookmarks with others on my LAN?

Copy the items you want to share (both individual bookmarks and entire

folders) to the My Shared Bookmarks collection. Then other OmniWeb 5 users

on your LAN will be able to see and use your shared bookmarks.

Can I use my bookmarks to help me deal with complicated
web pages that have a lot of links on them?

Absolutely. Just drag a URL to the shelf to create a folder full of the links from

that page, now turned into bookmarks. Alternatively, you can bring the page up

in the browser window and then click on the View Links as Bookmarks icon on

your Navigation Bar.

To make it even easier to navigate these bookmarks, you can drag the folder to

the tab drawer. All the links now appear in the drawer (just be aware that if any

of the links are mailto: links, dragging the folder to the tab drawer will open an

outgoing mail message for you in Mail).

What happens to a bookmark if the web site it points to
does a permanent redirect?

OmniWeb 5 transparently updates the bookmark address for you.
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Can I make bookmarks that take advantage of XML/RSS
feeds?

Yes. When you are browsing a page that has an RSS feed, a newspaper icon will

appear in the status bar at the bottom of the browser. Click on it and give the

news feed a location and a name. It will appear as an ordinary bookmark. You

can also view all your news feed bookmarks by showing the News Feed

collection on the bookmark shelf.
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Other Cool Stuff in OmniWeb 5

In this section, we answer other burning questions to help you make better use

of OmniWeb 5.

• If I see something cool on the Web, what’s the easiest way to send a link to a

friend?

• How can I save content to my hard disk?

• How does OmniWeb 5 help me manage my downloads more effectively?

• What are all those little icons at the bottom of the browser? And why do they

keep changing?

• How can I make poking around the web more convenient without

proliferating my bookmarks out of control?

• What’s with the changes to History?

• What AppleScript support is there for the new features in OmniWeb 5?

• How can I send you feedback about this application?

If I see something cool on the Web, what’s the easiest way
to send a link to a friend?

Select Send Link… from the File menu.

How can I save content to my hard disk?

There many ways to do this.
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Method 1: Save the Current Page as HTML

Select Save As… from the File menu. This lets you save the current web page as

an HTML document to your hard disk.

Method 2: Save all the Linked Images on the Current Page

Select Save Linked… from the File menu. From the sub-menu, select Images… .

You will now be asked to select a target location for the download. When you

have done so, OmniWeb will download all the linked images from that page to

the specified location.

Method 3: Save all the Linked Documents on the Current Page

Select Save Linked… from the File menu. From the sub-menu, select

Documents… . You will now be asked to select a target location for the

download. When you have done so, OmniWeb will download all the linked

documents from that page to the specified location.

Method 4: Save the Current Page as PDF

Select Print… from the File menu. From the Print dialog, click on the Save As

PDF… button.

Method 5: Summarize the Current Page and Save It

Click on the Summarize button on the toolbar. This will take you to a summary

created by Apple’s SummaryService, which you can save to your hard disk.
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How does OmniWeb 5 help me manage my downloads
more effectively?

In OmniWeb 5, we’ve given you a lot more control over downloading files. Here

are some of the new features:

⇒ The downloads window now uses a real toolbar that can be customized.

⇒ The downloads window is now a drag target for links. Just drag a link to

the window to start a new download.

⇒ Abandon has been added as an option on the Downloads window.

Abandon will stop the currently selected download(s), remove them from

the list, and will also remove the associated files from your hard disk.

⇒ You can now resume interrupted downloads (as long as the server the file

is coming from supports it). Use the Resume toolbar button to resume a

download.

⇒ If a download has errors, or fails, the downloads window reports the

error.

What are all those little icons at the bottom of the browser?
And why do they keep changing?

The Status Bar icons are added and subtracted dynamically, in response to the

current loaded page. Each of these icons either acts as a button to perform an

action, or it displays a menu of choices.

The buttons are:

⇒ Load Images: There are unloaded images on the page. Click this to load

them.
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⇒ Pop-up Trap: Ad-blocking preferences include the option to load pop-ups

but not display them, instead putting them in a Pop-up Trap. When there

are trapped pop-ups for the current page, this button appears on the

status bar. Click it to display a menu listing the trapped popups for the

life of the current tab.

⇒ AutoFill forms: Click it to AutoFill any form(s) on the page. Option-

clicking it to save the values currently entered in the form into your

currently active AutoFill set.

⇒ News Feed: When there is an available news feed (RSS or XML feeds) on

the current page, click this button to subscribe to the feed.

⇒ Add Search: This item appears when your cursor is active in a search

field on a web page. Click the icon to create a Shortcut for searching the

site that is accessible from the toolbar search field.

⇒ Cookie Jar: A cookie icon appears whenever there are cookies for the

current page.

⇒ Site Preferences: Appears in the Status Bar when viewing a site that has

custom preferences set. Click on it to access those preferences.

How can I make poking around the web more convenient
without proliferating my bookmarks out of control?

Use Marks to create temporary fast links in your History. This allows you to

poke around in the links on a web site, surfing to your heart’s content, and then

get back to the hub of your explorations quickly. You can either use the Marks

commands on the History menu, or you can place the Marks commands on the

Navigation Bar. In any case, there are four commands that you will find useful:

⇒ Mark this page: places a mark on the page to make it easier to get back

to later

⇒ Unmark this page: removes the mark on the current page
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⇒ Go to Previous Mark: loads the most recently marked page before the

one you are looking at right now

⇒ Go to Next Mark: loads the next marked page (“next” is determined

relative to the page yo are currently viewing)

Note that once you have several marked pages, the latter two commands cycle

you through them all.

Note that pages that are returned as the result of a search are always marked, as

is any visit to the Bookmarks page. The first page viewed in a particular window

is also marked.

What’s with the changes to History?

We moved History to Bookmark collections to standardize the way you search

for pages in OmniWeb 5, as well as to add more power to searching. One of the

things we gained by doing this is that History entries now have all the attributes

of bookmarks, including date last visited and visit count.

What AppleScript support is there for the new features in
OmniWeb 5?

In OmniWeb 5, we added AppleScript support for tabs and workspaces. Support

includes:

• Tabs

⇒ Add, move and remove tabs from browsers

⇒ Ask for and set the tab address

⇒ Reload and Stop tabs

• Workspaces

⇒ Change the name of a workspace
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⇒ Set the active workspace

⇒ Move browser windows between workspaces

How can I send you feedback about this application?

Select Send Feedback… from the Help menu. We have a truly awesome Support

team, and they will actually read and respond to every suggestion you make.


